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Foreword

This manual contains information about the image/firmware/system program (from now on referred to as image)
and how to get started with the HMI panel in the most common applications. The information in this manual is valid
for the latest versions of hardware at the time the manual was released. All documentation is available in our
Download center. For a list of the X2 HMI panels covered in this manual, see References. Visit Beijer Electronics
SmartStore for image updates and software downloads. Copyright © 2023 Beijer Electronics AB. All rights
reserved.The information in this document is subject to change without notice and is provided as availa-ble at the
time of publishing. Beijer Electronics AB reserves the right to change any information without updating this
publication. Beijer Electronics AB assumes no responsibility for any errors that may appear in this document. All
examples in this document are only intended to improve understanding of the functionality and handling of the
equipment. Beijer Electronics AB cannot assume any liability if these examples are used in real applications. In
view of the wide range of applications for this software, users must acquire sufficient knowledge themselves in
order to ensure that it is correctly used in their specific application. Persons responsible for the application and the
equipment must themselves ensure that each application is in compliance with all relevant requirements,
standards, and legislation in respect to configuration and safety. Beijer Electronics AB will accept no liability for any
damage incurred during the installation or use of equipment mentioned in this document. Beijer Electronics AB
prohibits all modification, changes, or conversion of the equipment.

Introduction

Note, Tip and Important Icons
This publication may include Important and Note icons where appropriate to point out safety-related, or other
important, information. It may also include Tips to point out useful hints to the reader. The corresponding symbols
should be interpreted as follows:

NOTE
The Note icon alerts the reader to pertinent facts and conditions.

TIP
The Tip icon indicates advice on, for example, how to design your project or how to use a certain function.

IMPORTANT
The Important icon highlights important information.

Trademarks
Microsoft, Windows, Windows Embedded CE 6.0 R3, Windows Embedded Compact 2013, Windows 7, Windows
Embedded Standard 7 are registered trademarks or trademarks of Microsoft Corporation in the USA and/or other
countries. Any additional trade names given in this documentation are trademarks of their corresponding owners.



References
The installation, technical data as well as cutout and outline dimensions of the panels are described in the
installation manual for each HMI panel. Please refer to the installation manuals and the iX Developer manuals for
further information.
This manual applies to the following X2 HMI panels:

X2 base v2 (all variants)

X2 pro (all variants)

X2 marine (all variants)

X2 control (all variants)

X2 extreme (all variants)

Name Description

MAEN361 Best Practice Image Update

MAEN328 Hardware and Installation Manual X2 base 5 v2

MAEN329 Hardware and Installation Manual X2 base 7 v2

MAEN330 Hardware and Installation Manual X2 base 7 v2 HP

Name Description

MAEN331 Hardware and Installation Manual X2 base 10 v2

MAEN332 Hardware and Installation Manual X2 base 10 v2 HP

MAEN333 Hardware and Installation Manual X2 base 15 v2 HP

MAEN350 Hardware and Installation Manual X2 pro 4

MAEN214 Hardware and Installation Manual X2 pro 7

MAEN265 Hardware and Installation Manual X2 pro 7 2eth

MAEN220 Hardware and Installation Manual X2 pro 10

MAEN222 Hardware and Installation Manual X2 pro 12

MAEN224 Hardware and Installation Manual X2 pro 15

MAEN270 Hardware and Installation Manual X2 pro 21

MAEN216 Hardware and Installation Manual X2 marine 7

MAEN217 Hardware and Installation Manual X2 marine 7 SC



MAEN218 Hardware and Installation Manual X2 marine 7 HB

MAEN219 Hardware and Installation Manual X2 marine 7 HB SC

MAEN226 Hardware and Installation Manual X2 marine 15

MAEN227 Hardware and Installation Manual X2 marine 15 SC

MAEN228 Hardware and Installation Manual X2 marine 15 HB

MAEN229 Hardware and Installation Manual X2 marine 15 HB SC

MAEN213 Hardware and Installation Manual X2 control 4

MAEN215 Hardware and Installation Manual X2 control 7

MAEN221 Hardware and Installation Manual X2 control 10

MAEN223 Hardware and Installation Manual X2 control 12

MAEN349 Hardware and Installation Manual X2 control 15

MAEN269 Hardware and Installation Manual X2 control 21

MAEN249 Hardware and Installation Manual X2 extreme 7

MAEN250 Hardware and Installation Manual X2 extreme 7 12V

MAEN251 Hardware and Installation Manual X2 extreme 7 HP

MAEN253 Hardware and Installation Manual X2 extreme 7 SL HP

MAEN255 Hardware and Installation Manual X2 extreme 12

MAEN256 Hardware and Installation Manual X2 extreme 12 HP

MAEN258 Hardware and Installation Manual X2 extreme 12 SL HP

MAEN323 Hardware and Installation Manual X2 extreme 12 CO

MAEN339 Hardware and Installation Manual X2 extreme 12 HP web

MAEN260 Hardware and Installation Manual X2 extreme 15

MAEN261 Hardware and Installation Manual X2 extreme 15 HP



MAEN263 Hardware and Installation Manual X2 extreme 15 SL HP

MAEN310 Hardware and Installation Manual X2 extreme 15 CO

MAEN340 Hardware and Installation Manual X2 extreme 15 HP web

MAEN355
Reference Manual iX Developer

Version: 2.40 SP7 b 2.47.473 and later

Name Description

MAEN831
Reference Manual iX Developer

Version: 2.40 SP7 b 2.47.417 and earlier

MAEN832 User’s Guide iX Developer

MU299609 BCS Tools – User Manual

NOTE

For image and software updates/downloads, visit Beijer Electronics SmartStore. Additional information, such as
Start Up guides, manuals and “Best practice” documents are available in our Download center.

NOTE
For specifications on supported USB memories and SD cards, please refer to the Hardware and Installation
manual for your specific X2 HMI panel.

Operating Systems



Image family Operating System license included Runtime license included

X2 base v2   

X2 base v2 HP   

X2 pro   

X2 marine   

X2 marine HB  iX Runtime

X2 extreme   

X2 extreme HP X2 extre
me SL HP

X2 extreme 12V

 

Windows Embedded Compact 2013 Runti
me (General embedded)

 

X2 control   

X2 marine SC   

X2 marine HB SC

X2 extreme SC  iX Runtime and CODESYS Runtime

X2 extreme HP SC   

X2 extreme SL HP SC   

Runtime Limitations

Target PDF Viewer sup
ported Media Player Object supported Web Browser su

pported

X2 base v2 (all sizes) No No No



Target PDF Viewer sup
ported Media Player Object supported Web Browser su

pported

X2 pro 4, 7 (except 7 – 2eth
)

 

 

No

 

 

Yes (.mpeg1)  

 

 

 

 

 

 

Yes

X2 control 4, 7

X2 marine 7, 7 SC

X2 marine 7 HB, 7 HB SC

 

 

 

 

Yes1

 

 

 

 

Yes (.mpeg1, .avi, .wmv, .mpeg42)

X2 pro 7 – 2eth, 10,

12, 15, 21

X2 control 10, 12, 15,

21

X2 marine 15 (all variants)

X2 extreme 7, 12, 15 (all va
riants)

1. PDF Viewer on X2 pro 7 – 2eth/10/12/15/21 is not fully supported. There are some limitations for display of

table of contents, headings, table text and scroll bar.

2. Only mpeg4 simple profile partial codec (included in WMV lib) is supported. More compressed/advanced

codecs of mpeg4, for example AVC, is not supported.

General Information

Default IP Addresses

These are the default IP addresses for the X2 HMI panels:

Port IP address

LAN A 192.168.1.1

LAN B (if available) DHCP

NOTE
Devices with 2 Ethernet ports MUST NOT have IP addresses in the same subnet.

NOTE For X2 control, and SC variants of the HMI panels:
The CODESYS runtime packages exists in two different versions: one version that sets LAN B to be an ethernet
port and LAN A to an EtherCAT port, the second version sets LAN B to be an ethernet port and LAN A to an
additional ethernet port. The default setting is to use ethernet on both ports.

Open Ports
In the firmware there are some ports that are open by default due to the operating system or that the internal
application requires it.



Type Description Open by default

UDP and TCP Project transfer (9999) Yes

UDP Netbios (137) Yes

UDP Netbios (138) No1

1. Filtered.

Configuration

To be able to configure the HMI panel, the following software is required:

iX Developer to do the configuration.

BCS Tools for X2 panels with CODESYS Runtime.

Welcome Screen

Apply power to the HMI panel. Within 10–15 seconds, the welcome screen will appear (if there is no iX Runtime

project on the HMI panel).

The following items about the HMI panel are listed:

Size of external memory card, if applicable

IP address

Panel image version

CODESYS Runtime version

If a project has been downloaded to the panel, it will be loaded automatically. If there is no project in the panel,
touching the screen will display the service menu. If there is a SD card, or USB flash drive, inserted into the panel,
and the project on the SD card/USB flash drive differs from what is saved in the HMI panel, the user is asked if the
project and IP-settings should be restored.

The Welcome screen for a X2 base 7 v2 HP.



Position Description

1 Panel type

2 External memory card status

3 Network status. An attached network cable is indicated with an asterisk.

4 Panel image version.

Service Menu

The service menu for the HMI panel can be accessed before a project is downloaded. The service menu can only
be accessed locally, not through a remote connection.

Service Menu in an Empty Panel
When no project is loaded in the panel memory, the panel will boot, displaying the welcome screen.

Press anywhere on the panel display to enter the service menu.

Service Menu in a Panel Containing a Project
Perform the following steps to enter the service menu:

1. Apply power to the panel.

2. When the hourglass appears, press a finger on the screen and hold until the following message appears on the

screen: “Tap anywhere on screen or touch calibrate will start in 10 seconds.”.

3. Press the screen once again to enter the service menu.

4. If the service menu is password protected, you will be prompted for a pin code. Enter the pin code.

IP Settings
The following parameters can be set:

IP address

Subnet mask

Default gateway



DNS settings for the Ethernet port on the HMI panel

The default setting for LAN A is: IP address 192.168.1.1, Subnet mask 255.255.255.0.

If the HMI panel is equipped with two ethernet ports, then a second tab is shown in the IP settings dialog. The
default setting for LAN B is Obtain an IP address via DCHP.

NOTE
Devices with 2 Ethernet ports MUST NOT have IP addresses in the same subnet.

Date/Time

The date/time settings dialog allows setting of the timezone, date, time and also setting automatic adjustment of
clock for daylight saving.

Edit Project



The edit project/restore image dialog allows modifying the project in an HMI panel and, if needed, restore the
panel image to a previous version.

Copy Project from External Memory
This option enables the function to copy an iX Developer project from an external memory, USB flash drive or
storage device connected to one of the HMI panel USB ports.

Copy Project to SD Card
This option enables the function to copy the iX Developer project and all the files needed to run the application to
an external SD card.

Copy Project to USB Memory
The iX Developer project and all the files needed to run the application are copied to an external USB flash drive
or other USB-connected storage device. Make sure that the storage device is connected before trying this option.

Delete Project
The iX Developer project and all its corresponding files are deleted from the HMI panel. There is no way of
undeleting a project, make sure that the project should be deleted before confirming the deletion.

Restore HMI Panel to Previous Image
The HMI panel image can be restored to the panel image version the HMI panel was using before a new panel
image was loaded into the panel. This option is used to restore a panel to a known working condition.

NOTE



If the operator panel contains a CODESYS Runtime, then the correct CODESYS Runtime version (that
corresponds to the chosen image version) must be downloaded to the panel after the HMI panel image version
has been changed

Restore Panel to Factory Image
The HMI panel image can be restored to the HMI panel image version that the panel was shipped with from the
factory. Use this option if all else fails, this will downgrade the HMI panel to its initial state.

Self Test
Self tests are only carried out at Beijer Electronics service centers, additional hardware needed.

Touch Calibrate
The touch calibration screen enables the function to re-calibrate the touch screen. The re-calibration consists of
five steps, where a crosshair on the screen is pressed and held. Take care and try to do this as precise as
possible, an incorrect calibration makes it hard to use the HMI panel.

Debug Logging

The Debug Logging dialog enables the function to enable and disable the debug logging on the HMI panel (default
setting is disable). It also enables the function to move a previously created set of debug log files from the HMI
panel to an USB flash drive.

Option Description

Enable logging

The HMI panel will start or continue to store additional debug log information in log files. A t
otal of 10 log files of a maximum of 100 kB per file will be kept in the HMI panel internal me
mory. If the log files are filled to the limit, the oldest file will be overwritten first (FIFO method
).

This function should only be used for a limited time, as it will continuously write data to the fl
ash memory and by that add to the flash memory wear.

Disable logging The HMI panel stops storing debug log data. The data will remain in the HMI panel internal 
memory.

Move log to USB 
memory Moves the debug log files in the HMI panel to an external USB storage device.

Diagnostic

NOTE



The following information is valid for Image release 2.2 or later.



Category Description

ABOUT Shows information about the use and status of the HMI panel.

OS/BOOT LOADER INFOR
MATION Shows information about Operating System and Boot Loader versions.

INTERNAL STORAGE Shows information about the internal storage.

PANEL INFO Shows the make, model and other information about the HMI panel.

SYSTEM BOARD Shows the hardware information of the System board in the HMI panel.

FRONT CARD Shows the hardware information of the Display card in the HMI panel.

SELFTEST
Shows the result of the last self test.

(Information only valid for Beijer Electronics service centers)

FOLDERS Shows information about internal/external flash memory.

MEMORY Shows information about capacity and availability for the RAM memory.

NETWORK INTERFACES Shows IP configurations and MAC addresses for the network adapters in the HM
I panel.

SERIAL PORTS Shows information about the serial ports.

NOTE
The information (layout and number of screens) on the diagnostic screen pages appear differently depending on
screen size.

Export Diagnostic Information
Tap Save to USB memory to export the diagnostic information to an external USB flash drive or other USB-
connected storage device. Make sure that the storage device is connected before trying this option.

Image and CODESYS Runtime Update

The HMI panel comes pre-loaded with a system image (including firmware and system program). Images and the
Image Loader utility, can be downloaded from the Firmware section in our SmartStore. CODESYS runtime is
available from the Firmware section in our SmartStore.

IMPORTANT
CODESYS runtime update is only applicable for devices with a CODESYS runtime license, such as X2 control and
SC variants of X2 marine and X2 extreme. For more information, see Operating Systems.

The image/Image Loader utility is used for:

Updating the image by,

creating an Image Loader SD card or USB flash drive

transferring an image to an HMI panel through Ethernet

Updating the CODESYS Runtime by,

creating an auto-install package for SD card or USB flash drive

transferring the CODESYS Runtime over Ethernet



In some occasions it is necessary to make a complete system update via Make Recovery SD card.

IMPORTANT
On an X2 pro or X2 control HMI panel with image version 2.0 b775 or older, we recommend updating the image
using Make Recovery SD Card. This means that the iX Developer project and IP settings must be backed up from
the panel before the image is updated. See section Update the Image Version Using Recovery SD Card on how to
do the backup.

IMPORTANT
On an X2 extreme HMI panel with image version older than 2.0 b365, we recommend updating the image using a
Make Recovery SD Card. This means that the iX Developer project and IP settings must be backed up from the
panel before the image is updated. See section Update the Image Version Using Recovery SD Card on how to do
the backup.

To summarize, the image/CODESYS runtime can be updated in the following ways:

Update method iX Developer project deleted by updating IP address reset by updating

USB No No

SD No No

Ethernet No No

Recovery SD card1 Yes Yes

1. Only available for image update.

On panel startup, in the welcome screen, it is possible to see the image version.



The welcome screen for an X2 pro 7 panel.

IMPORTANT
When updating the system image through “Make recovery SD card” an SD card formatted with FAT16/FAT32 and
maximum 32 GB must be used.

Update the Image Using USB or SD Card

Do the following:

1. Download your image from Beijer Electronics SmartStore.

2. Unzip the downloaded file and start the Image Loader application.

3. Connect a USB flash drive or SD card to the computer.

4. In Select drive:, choose the connected USB flash drive or SD card.

5. Click Create.

6. When finished, eject the USB flash drive or SD card.



7. Connect the USB flash drive or SD card to the powered off unit and power it back on.

8. Select Yes to confirm the Update.

The update is now completed.

Update the Image Over Ethernet
The Image Loader utility can be used to update the image over Ethernet.

NOTE
Before trying to update the image over Ethernet, make sure that your PC is on the same IP-subnet as the HMI
panel. If your HMI panel has an IP address of 192.168.1.1, and a subnet mask of 255.255.255.0, then your PC
must have an IP address in the range of 192.168.1.2 – 192.168.1.254 and a subnet mask of 255.255.255.0, in
order to communicate with the HMI panel.

Do the following:

1. Enter the panel target IP address in the dialog and click on Update to start the update.

2. The dialog shows the current installed image and the new image the panel will be updated to after the upgrade.

Click on Update now! to confirm the update.



3. A progress bar shows the update status. When the update is done, the panel will restart. The update is now

completed.

NOTE
If the HMI panel contains a CODESYS Runtime, then the CODESYS Runtime must be transferred to the HMI
panel after the image has been updated. See section Update the CODESYS Runtime Version Using USB or SD
Card or Update the CODESYS Runtime Version Over Ethernet.

Update the Image Version Using Recovery SD Card
In a complete system update the IP settings will be reset to default values and the iX Developer project will be
deleted. To keep the IP setting and the iX Developer project it is recommended to make a backup of the iX
Developer project and make a note of the IP settings prior to an image update.

NOTE
When updating the system image through “Make recovery SD card” an SD card formatted with FAT16/FAT32 and
maximum 32 GB must be used.

Copy iX Developer Project and IP Settings
IP settings and export of the current iX Developer project is done via the service menu. Perform the following
steps to enter the service menu:

1. Apply power to the panel.

2. When the hourglass appears, press a finger on the screen and hold until the following message appears on the

screen: “Tap anywhere on screen or touch calibrate will start in 10 seconds.”

3. Tap the screen once again to enter the service menu.

4. If the service menu is password protected, you will be prompted for a pin code. Enter the pin code.

IP settings are found in the “IP settings” dialog. Please write down IP settings for LAN A and LAN B for future use
before proceeding. The iX Developer project is copied in the Edit Project / Restore Image dialog.



You can choose to export the project to an SD card or USB.

1. Connect the USB flash drive or SD card that should be used for the backup to the panel.

2. Select Edit Project / Restore Image.

3. Select Copy Project to SD Card or Copy Project to USB Memory.

The iX Developer project and all the files needed to run the application are copied to the SD card or USB flash
drive. Make sure that the storage device is connected before trying this option.

Update the Image
Do the following:

1. Download your image from Beijer Electronics SmartStore.

2. Unzip the downloaded file and start the Image Loader application.

3. Connect an SD card to the computer.

4. In Select drive:, choose the connected SD card.



5. Make sure to check the Make Recovery SD card checkbox.

6. Click Create.

7. When finished, eject the SD card.

8. Connect the SD card to the powered off unit and power it back on.

9. In the dialog that opens, select Yes to confirm the Update.

The update is now completed.

NOTE
When the image is updated, the iX project and IP address can be restored again via the service menu. The IP
address is set in the IP Settings dialog, and the project is reloaded via the menu item Edit and Copy Project from
External Memory. Make sure that the storage device is connected before proceeding with the import.

Update the CODESYS Runtime Version Using USB or SD Card

NOTE
Refer to document SUEN00392, available at Help Online, for more details and recommendations on using the
X2/BoX2 series range of products with embedded CODESYS runtime. To update the CODESYS Runtime, the
folder containing the CODESYS .cab-files listed below must be specified in the Image Loader utility. The existing
Power Management and EtherCAT Distributed Clock settings are shown in the Image Loader utility and can be set
before updating the CODESYS Runtime.



Do the following:

1. Select the folder that contains the CODESYS files.

2. Select the desired options for Retain data and EtherCAT and click Create auto-install package.

NOTE

The PLC functionality has support for storing non-volatile variables. Those variables can be stored dynamically

in two different modes:

Power-fail mode (Default setting)

If the voltage drops below a hardware given threshold (that is, during a power loss or power dip), the

system instantly copies all persistent data defined in the PLC application from RAM into the battery

backed SRAM. They are verified and restored when the device is restarted.

Cyclic mode

The PLC is instructed to store all retain and persistent data directly into SRAM synchronously with every

PLC cycle. This means all device types can use the whole available memory, which is 128 kB. However,

writing to the SRAM might increase the configured PLC cycle depending on the size of used retain and

persistent data, because a SRAM is naturally slower than a RAM. This possible increase is dependent of

the application and to find out about the possible increase one would need to monitor the configured



task(s) of the project. For projects with large amounts of persistent data, cyclic mode is recommended.

3. Save the auto-install package to your connected USB or SD card.

4. Eject the USB or SD card.

5. Connect the USB flash drive or SD card to the panel and boot the panel.

6. Answer Yes when asked if the current version of Soft PLC should be replaced.

7. When asked if DC support for EtherCat should be installed, answering Yes or No will have the following

consequences:

Yes: LAN A will be reserved for EtherCAT and LAN B for ethernet communication

No: Both LAN A and LAN B can be used for ethernet communication

8. Answer Yes when asked if Power-fail supported retain should be enabled.

9. Eject the USB flash drive or SD card and reboot the HMI panel.

The update is now completed.

NOTE
Before downloading a new CODESYS Runtime, the HMI panel image should always first be downloaded to the
HMI panel again, even if there are no changes to the HMI panel image. If only the CODESYS Runtime is installed,
then this may result in problems connecting to and communicating with other devices.

Update the CODESYS Runtime Version Over Ethernet

NOTE
Refer to document SUEN00392, available at Help Online, for more details and recommendations on using the
X2/BoX2 series range of products with embedded CODESYS runtime.To update the CODESYS Runtime, the
folder containing the CODESYS .cab-files listed below must be specified in the Image Loader utility. The existing
Power Management and EtherCAT Distributed Clock settings are shown in the Image Loader utility and can be set
before updating the CODESYS Runtime.



1. Select the folder that contains the CODESYS files.

2. Input the Target IP address for the HMI panel.

3. Press the Get info button to make sure that communication with the HMI panel is working.

4. Select the desired options for Retain data and EtherCAT.

NOTE
The PLC functionality has support for storing non-volatile variables. Those variables can be stored dynamically in
two different modes:

Power-fail mode (Default setting)
If the voltage drops below a hardware given threshold (that is, during a power loss or power dip), the system
instantly copies all persistent data defined in the PLC application from RAM into the battery backed SRAM. They
are verified and restored when the device is restarted.

Cyclic mode
The PLC is instructed to store all retain and persistent data directly into SRAM synchronously with every PLC
cycle. This means all device types can use the whole available memory, which is 128 kB. However, writing to the
SRAM might increase the configured PLC cycle depending on the size of used retain and persistent data, because
a SRAM is naturally slower than a RAM. This possible increase is dependent of the application and to find out
about the possible increase one would need to monitor the configured task(s) of the project. For projects with large
amounts of persistent data, cyclic mode is recommended.

1. Press Update to perform the update.

NOTE



This button is disabled until communication has been established with the HMI panel, by previously pressing

the Get info button.

2. Once finished, the HMI panel will automatically reboot. The update is now completed.

NOTE
Before downloading a new CODESYS Runtime, the panel image should always first be downloaded to the HMI
panel again, even if there are no changes to the panel image. If only the CODESYS Runtime is installed, then this
may result in problems connecting to and communicating with other devices.

Custom Welcome Screen
The default background picture and text of the Welcome Screen on an X2 HMI panel can be replaced with a
custom picture and text. The text color of the screen can also be modified or removed.

1. Create a background picture with the following characteristics:

The exact same resolution as the panel the picture will be used on.

Name: iXCustomSplash.bmp

Picture format: .bmp (bitmap)

2. Create a configuration file for the text:

Name: iXCustomSplash.cfg

Parameter format: object=yes/no,RGB color in hex

Default settings:

Title=no,0xFFFFFF

TerminalName=no,0xFFFFFF

Info=yes,0xFFFFFF

Hint=no,0xFFFFFF

UserInfo=no,0xFFFFFF

Parameter description:

UserInfo: Panel activity only appears during project processing.

Example iXCustomSplash.cfg for Welcome Screen above:

http://ixcustomsplash.cfg


1. Create an iX Developer project for the panel for which you want to replace the Welcome Screen and text.

2. Add the picture and the configuration file to the project’s Project Files.

3. Download the project to the HMI panel.

4. Reboot the panel to load the new Welcome Screen.

TIP
To check the panel resolution, start iX Developer. In the wizard, select the correct panel type. Check the technical
data displayed for the HMI panel. If a project already exists, simply use the toolbar and select the Project tab, click
on Settings and select Display/Target. You will find the resolution under Screen Size. All parameters in the
configuration file are white space and case insensitive and can be specified in any order. The last setting for a



parameter always overrides the previous.

Service Warnings

In the system image there are three types of Flash Wear Warnings:

Rapid flash wear warning

Message: “The internal storage memory lifetime is rapidly decreasing. Please review the online

documentation on how to reduce wear.”

Occurs when the user’s program is quickly increasing the flash memory’s wear.

It is evaluated by every 10 % wear level.

Flash lifetime warning (80 – 100 % wear)

Message: “The internal storage memory is soon reaching its expected lifetime. Please review the online

documentation on how to reduce wear.”

Occurs when the internal storage memory has reached 80% of its expected lifetime.

Flash lifetime warning (exceeded wear)

Message: “The internal storage memory is reaching its expected lifetime. The unit should be scheduled

for maintenance service.”

Occurs when the internal storage memory has exceeded its expected lifetime.

Other warnings:

Battery warning

Message: “The unit internal battery is due and needs to be replaced.”

Occurs when internal battery voltage is to low to be detected.

Image update error message

Message: “Incorrect image CRC32! image NOT updated!”

Occurs when image update has been aborted due to corrupt update package.

Bootloader update error message

Message: “Incorrect bootloader CRC32! Bootloader NOT updated!”

Occurs when bootloader update has been aborted due to corrupt update package.

Warnings are visual 1 min after boot up and once a day at 09:00 (local time) unless suppressed.

The service warning message can be suppressed for 30 days by checking the checkbox and pressing OK.

The warning message can be suppressed via settings menu in Service menu – Diagnostics -Settings in the

lower left corner.

This suppression is active until next time the warning message is active. This is evaluated every 10% wear

level.

Service Warning Suppression



A service warning may appear shortly after firmware upgrade indicating that the unit internal disk lifetime is rapidly
decreasing. This could be due to a less efficient way of writing to flash in the previous installed firmware version. If
this happens, we recommend to suppress the warning using the following procedure.

1. Enter service menu.

2. Enter diagnostics.

3. Enter settings.

4. Suppress disk wear warning.



Getting Started and Commonly Used Functions

Create and Download Project Using iX Developer

Create a Project in iX Developer
For information on creating a new project in iX Developer, see the iX Developer Reference Manual.

Download the iX Developer Project
To download an iX Developer project to an HMI panel, you can choose to either export the project to a USB/SD
card or to download the project over Ethernet.

Export Project to USB or SD Card

1. Open your project in iX Developer.

2. Select the Project tab and click Export.

3. In the pop-up window, find and select the root folder of your USB/SD card, and save the project there by

clicking Save.



4. Eject the USB/SD card.

5. Connect the USB/SD card to your HMI panel and boot it.

6. Open the Service Menu, select Edit Project / Restore Image.

7. Select Copy Project from External Memory.

The installation is now completed.

Download Over Ethernet

1. Connect the HMI panel to the PC via an Ethernet connection.

2. Open your project in iX Developer.



3. Select the Project tab and click Download.

4. The Download Project dialog opens, and all devices connected in the network are listed with information about

IP address and device type. Select your HMI panel from the list.

5. Check that the IP address is correct and click Download.

Optional: Click the Include compressed project check box, to compress the project and save it as a ZIP file.

Optional: Click the Password protected check box and enter a password, to protect the ZIP file.

Optional: Click the Copy downloaded project to Memory card check box, to enable SD card backup of the

project and settings.

1. The HMI panel responds to a download request by stopping any current project. The installation is now

completed.

 Enable Diagnostics Page 
The diagnostics page shows diagnostic values from the panel. The diagnostic values include internal temperature,
available RAM, used storage, connection and database errors and other system-related markers. The diagnostic
page can be viewed after the project is downloaded to the panel. In iX Developer:

1. Open Web server configuration from System ribbon tab. Set values needed to access web server and enable

web server for the project.

NOTE

The URL for the diagnostics page should include the assigned port number.

2. Add system tags, used on the page, manually to the project. If the system tag is missing, ‘-’ will be displayed on

the page.

NOTE

The following system tags are available:

Communication Errors (count) (SystemTagCommunicationErrorMessage)

Communication Error Message (SystemTagCommunicationErrorMessage)

Database Error Active (SystemTagStorageErrorActive)

Database Error Message (SystemTagStorageErrorMessage)

Database Max Size Exceeded (SystemTagStorageMaxSizeExceeded)

Current Date and Time (SystemTagDateTime)

Debug Logging Enabled (SystemTagDebugLoggingEnabled)

3. Select Functions – Tags – Add – Add System Tag…. Select and add needed tags in System tags dialog.



4. Deploy by either upload files via FTP or copy into the ProjectFiles folder. Diagnostics page files are installed

with iX Developer installation and reside in ‘iX Developer 2.40 SP7\Bin\DiagnosticsPage’.

Enable FTP server for the project.

On the System ribbon tab (1), within the Servers group, click FTP (2).

In the dialog, check the Enable FTP server checkbox (3).

(Optional) Set a username and password.

Click OK.

Download the project to the panel through Project – Download.

Connect to the panel. Use FTP settings specified in the project with the help of any FTP client.

Create a new folder named ‘diagnostics’ in the ‘Website’ folder and copy diagnostics page files into it.

Use this URL to access the diagnostic page: http://<image_ip_address><:port>diagnostics/index.html to access
the page. Use the port defined in the web server configuration. If Forms authentication is enabled for the web
server, user is first taken through authentication process. The page is updated asynchronously every 2 seconds
with the latest data.

NOTE
For more information about how to use FTP, see Remote Access (FTP and VNC) in iX Developer 2.xx,
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Create a Project in BCS Tools and Download the PLC Program

Create a Project in BCS Tools
If you are using an HMI panel with a CODESYS Runtime you need to configure the HMI panel through BCS Tools.
BCS Tools can be downloaded from Beijer Electronics SmartStore. Once you have downloaded and opened BCS
Tools, do the following to create your project:

1. Click File > New project….

2. Choose Standard Project.

3. In the BCS Tools Standard Project window, click the Choose the device category: drop-down and select the

Edge Controllers group.

4. Click the Choose the device model: drop-down and select your HMI panel from the list.



NOTE

The PLC functionality has support for storing non-volatile variables. Those variables can be stored dynamically

in two different modes:

Power-fail mode (Default setting)

If the voltage drops below a hardware given threshold (that is, during a power loss or power dip), the

system instantly copies all persistent data defined in the PLC application from RAM into the battery-

backed SRAM. They are verified and restored when the device is restarted.

Cyclic mode

The PLC is instructed to store all retain and persistent data directly into SRAM synchronously with every

PLC cycle. This means all device types can use the whole available memory, which is 128 kB. However,

writing to the SRAM might increase the configured PLC cycle depending on the size of used retain and

persistent data, because a SRAM is naturally slower than a RAM. This possible increase is dependent of

the application and to find out about the possible increase one would need to monitor the configured

task(s) of the project. For projects with large amounts of persistent data, cyclic mode is recommended.

IMPORTANT

The Powerfail/Cyclic setting must match the settings made in “Retain data options”, see Update the

CODESYS Runtime Version Using USB or SD Card or Update the CODESYS Runtime Version Over

Ethernet.

5. Make sure that Create directory for project is checked and click Next.

6. In the following window, choose the programming language for the POU created by the wizard, and click Finish.

Getting Started and Commonly Used Functions



Compile the Project
When the program is ready, a compile is needed to generate the executable code for the HMI panel.
There are two ways to compile the project, the Generate code function which is an offline compile and the online
compile, which is triggered when logging into the HMI panel if there is a code change from the last online session.

Compile Offline

NOTE
When a program change has been made to the project, the project must be compiled.

The offline compile is triggered by using the option Generate code from the Build menu.

The other two options, Clean/Clean all, will remove the generated application binaries and forces BCS Tools to
regenerate the application. After a Clean or Clean all, the controller must be stopped to be able to update the
application.

NOTE



A project can still be changed online if the offline compile is being used, if it is only program code changes.

Compile Online

NOTE
When a program change has been made to the project, the project must be compiled. This compile is triggered
when logging into the CPU if there is uncompiled program code. If there are any compile errors, the login
procedure will be interrupted. The compilation must be successful to be able to login to the CPU.

If the compilation is successful, a question of online change will be shown.

Download the PLC Program

There are two ways to transfer the program code to your HMI panel, the Download and the Online Change

function.

The Download function is a mode for downloading new projects and also current projects where the PLC

parameters have been changed; hardware configuration, task changes etc.

The Online Change function is a mode for downloading changes while the CPU is in RUN mode. There is no

restriction regarding how large the code change can be, as long as the only change is the program code, the

online change function is always available.

Download in STOP Mode

To download a new application or an application with hardware changes, task changes etc, the CPU must be in

STOP mode.

When logging into the CPU, BCS Tools will prompt that a download needs to be made.

When the Yes button is pressed, the CPU will enter STOP mode and the application is downloaded. When the

download is complete, BCS Tools will enter the online state with the CPU in STOP mode.

To set the CPU into RUN state, press the RUN button in BCS Tools.



Online Change
The online change function is a mode for downloading changes while the CPU is in RUN state. There is no
restriction regarding how large the code change can be, if the only change is the program code. When a change is
made in the program code, BCS Tools will prompt with the following message to let the user decide whether to
make an online change or a download with the PLC in STOP mode.

When a login attempt is made and the program code differs between BCS Tools and the PLC, online change is
available. When a change in parameters, tasks or other parameter-related options are made, no online change
can be performed. BCS Tools will prompt with a message asking if you want to perform a download instead. Click
Yes or No. Clicking Details… shows the code generation timestamp of the PC vs the PLC.

Boot Application
The Boot Application is the program code that the CPU will load and execute, after powering on or resetting the
system. When a download is made with the CPU in STOP mode, the downloaded project will be registered as a
Boot Application. An online change updates the Boot Application per default.

Reduce Flash Wear by Storing Data on SD Cards
Beijer Electronics recommends using an industrial SD card instead of the built-in flash memory when data logging
is performed. The capability to use an external SD card for data logging on X2 HMI panels was introduced in iX
Developer 2.40 SP5. Since extensive writing to the flash memory can cause wear problems and possibly
premature failures, the alternative to writing to an exchangeable SD card will potentially lengthen the lifetime of the
panel. An SD card is easy to replace compared to a built-in memory. In addition, the memory size of the SD card is
normally much larger than the built-in flash memory.

To set up the SD card database in iX Developer:

1. Go to Project/Settings. Select Database and select SD Card in the dialog.



2. Click on the OK Button to confirm the new settings. When the location of the database is changed from flash to

SD card (or vice versa) in an existing application, the database will be automatically copied to the new location

once the project is transferred to the panel. This will be started immediately after the project transfer has taken

place and hence a somewhat slower project start-up time can be noticed. It is advisable to do a backup of the

database in case something happens during the database copy operation. If during runtime of the panel, the

SD card is removed and the chosen location for the database is the SD card, the panel will close the application

and attempt to reboot until either an SD card is reinserted into the panel, or a project is downloaded to the

panel with the location set to “Hard disk”. Please note that if any scripting has been done towards the database,

then these scripts need to be manually adapted to work with the new location (flash or SD card). If Audit Trail is

enabled for the project and if the database is stored in SD card, the transfer client will not provide the option to

keep/remove audit trail in an existing project. It will always keep the audit trail database. If the user wants to

clear the audit trail database for the same project, the SD card needs to be inserted into a PC and manually

delete the audit trail database file. It is also recommended to track the flash wear status in your iX Developer

project. The following System Tags can be used for that purpose:

System Tag Description

Flash Memory Life Time Used The usage of the device lifetime (in percent).

Flash Memory EOL Info

Information about the flash memory end of life. The three possible values are
:

•   Normal

•   Warning – Consumed 80% of reserved block

•   Urgent



Please see document Best Practice Database on SD card or flash memory for more detailed information.

Additional Information for X2 control and SC Variants

Runtime Version
The X2 control platform (including SC versions of other X2 panels) allows the end-user to install a CODESYS
Runtime version of their choice. Several different versions are available. For information regarding updating the
CODESYS Runtime, please see chapters Update the CODESYS Runtime Version Using USB or SD Card and
Update the CODESYS Runtime Version Over Ethernet.

Change EtherCAT / Normal Ethernet
The CODESYS runtime packages exist in two different versions: one version that sets LAN B to be an ethernet
port and LAN A to an EtherCAT port, the second version sets LAN B to be an ethernet port and LAN A to an
additional ethernet port. The default setting is to use ethernet on both ports.
If CODESYS runtime is installed with EtherCAT support, the panel image has to be reinstalled, using the Image
Loader utility, before the non-EtherCAT CODESYS runtime version can be reinstalled.

CODESYS License

Control License
All X2 control, X2 extreme SC, and X2 marine SC HMI panels are equipped with a CODESYS Runtime license.

Load Project
There is a hard connection between the installed CODESYS runtime version and the CODESYS PLC project that
is running on the panel. If the CODESYS runtime version is upgraded or downgraded the PLC application must be
recompiled with the correct settings for the target runtime version that is used.

Device Description
The device description XML-file contains information that CODESYS needs to be able to build projects for the
CODESYS runtime. The installed device descriptor XML-file CODESYS runtime version must match the CODESYS
runtime version used in the HMI panel. Each available CODESYS runtime package has its corresponding XML-file.
This XML device descriptor file needs to be installed in the CODESYS development environment.

The installation button in CODESYS 3.5 SP10 Patch 1.

Head Office

Beijer Electronics AB



Box 426

201 24 Malmö, Sweden
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